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Comparion Release Notes June 2024

June 01, 2024 | Version 6.18.1

Summary of Changes: In this release, we are excited to introduce you to the following new functionalities:

e Color Settings

e Abstain Judgments

e Model Wording

e Resource Aligner Portfolio Canvas

e Contributions Grid Display

e Time Period Dependencies

e Dashboard New Panels

e Pairwise Verbal Scale Ratio

o Pairwise No. of Diagonal setting in the evaluation
e Collaborative Brainstorming Whiteboard Access
e Information Documents Enhancements

e Disabled Alternatives Enhancements

e Model Linkage

e Collect input Settings combined into one page

e Evaluation Judgment Count

Other minor enhancements include:

e Show the %Effectiveness on the Time Period Results screen
e Pagination when adding alternatives

e Reset Zoom on the Hierarchical Pie Chart

e Minor Dashboard Enhancements

o Simplified Measurement Methods screen

e Grid, Charts, and Sensitivities Enhancements

e Changes on the Inconsistency Improvement screen

e Font Size in Sensitivities

e Quick Help Enhancements

e Custom Column in TeamTime Meeting

e Select Participant on View Only Mode Evaluation

e Gradient Sensitivity Legend Lines

e Edit Model Name

e Radar Sensitivity Enhancements

e Open Model Lookup in another window

e "Forgot password" on the Signup/Login page

e Re-arrange columns on the Alternatives/Objectives Grid

¢ Model Name and Description in Collaborative Brainstorming Meeting
e Model Details Summary

e Tooltips to spell out labels on RA Columns

Color Settings
We now have flexible ways to assign colors to the Alternatives and Objectives:

e Custom Color - color is assigned to alternative and objective individually.(Note: This is also available on the previous
version but only on limited screens - Alternatives Grid and some Sensitivities)
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Alternative Priorities
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69.84%
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W AS/400 Replacements

M Cisco Routers

M Customer Service Call Center

M Deskiop Replacements

W EMC Symmetrix

M Firewall and Antivirus Licenses

M Iron Mountain Backup Service

W Laptop Replacements

W Mobile Workforce Pocket PCs

I Oracle 9i Upgrade
PeopleSoft Upgrade

n Mountain Backup Service
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6583%

Laptop Replacements 45.08%

75 59%
PeopleSoft Upgrade 69.73%
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Proserve System Upgrade 60.80%

Thin Client Implementation

100.00%

Plumtree Corporate Portal
ProServe System Upgrade
[ sSales Force Laptops
[l SRDF Site/Service
I Thin Client Implementation

o Color Palettes - a new option where the Project Manager can select from predefined sets of colors for all the alternatives

and objectives.

~ . Comparion model: IT Portolio Optimization

FoOLt

& MANAGE MODELS‘ £ DEFINE MODEL‘ &3 coLLECT INPUT EBRUNPTTENNI] 4T ALLOCATE | @ DASHBOARDS | & REPORTS

B> Add page to

ZReload @Onine @@lock @ [ Snapshots i

— - Grant Type:
E5ll | Local | Global [HESNNMGNN

% of Maximum -

FontSize
- 14 Dt -

54 Components Auto font size

> Overall Results
_
@ Objectives Chart Alternative Pri
£ Attematives Grid Mo
. jecti AS/400 Replacements 73.94%
£ Objectives Grid Objectives Local _ Global e
= Dynamic Leverage Knowl...  2049% 20.49%
i Performance bRl C.stomer Service Call Center 69.84%
H= Gradient CustomerA..  2552%  523%
l*2D InternalAcc... | 46.38% ~ 9.5% EIRNASWNIEWSINIS 74.31%
= Head-to-head Improve Organi..  38.26%  38.26%
FHMixed Improve Se. 926%  354% ESWIGESMITIETN 91.23%
> Sensitivity A Alternatives el B L)
2\ One atatime. Improve Ti PAE LN RIA I Firewall and Antivirus Licenses. 65.15%
B Fourata ime Manage Re. 50.8% 19.44%
> Others Maintain Servic. LRGN 1ron Mountain Backup Service 65.83%
e ea—— Scaleabity 60%  365%
o s View i Responsive 2% 122% [ 46.08%
Resources 2% 12%
Leverage P 2% 54%
Vendor | 6667% 1081%
Business = 3333%  54% | PeopleSoft Upgrade 69.73%
Financials 1356%  1356%
Maximize N 3333% 452  Plumiree Corporate Portal 94.76%
Maximize ROl 66.67%  9.04%
ProServe System Upgrade ‘ 60.80%
65.69%

100.00%

Thin Client Implementation

Marcia

The Custom Color and Color Palette settings are available on the Synthesize screens (Charts, Grid, Sensitivities).

Abstain Judgments

M AS/400 Replacements

Cisco Routers.

Customer Service Call Center

Desktop Replacements

EMC Symmetrix

Firewall and Antivirus Licenses

I Iron Mountain Backup Service

M Laptop Replacements

Il Mobile Workforce Pocket PCs

W Oracle 9i Upgrade
PeopleSoft Upgrade
Plumtree Corporate Portal
ProServe System Upgrade

I Sales Force Laptops.

I SRDF Stte/Service

M Thin Client Implementation

Allows the evaluator to enter an "Abstain Judgment" instead of just skipping the evaluation. Abstain judgment can be enabled
from the Set Measurement Options > Evaluation Settings:

© 2019 Expert Choice. All Rights Reserved



Expert Choice Comparion® Help Document

x

Evaluation settings 44

#=Evaluation status Order of evaluation (top down or bottom up):

@ Set Measurement Options ' () Evaluate objectives first (top down)

e Anytime Evaluatio% (@ Evaluate alternatives first (bottom up)

5% Send Invitations —

: [_] Hide navigation box/Evaluation progress
@ Collect my input [ Hide navigation step buttons
[ Data Grid Show next unassessed

2e2TeamTime™ Evaluation (] Allow abstain judgments (Anytime Evaluation only)
2s2Select Participants

(") Auto advance on
5 Invite Participants @ Auto advance off, and ask evaluator (once) if they want to turn it on
(O Auto advance off, and don't ask evaluator if they want to turn it on

0w65t'"9,,_."“\_,‘_}u_r~—~ R i iy i W NP~

Abstain judgment is applicable to all measure methods as radio button selection for rating, or as a toggle (non-rating).
Rate the preference of Alternatives with respect to multi-rating @ o=

a2 WRT multi-rating (%

a2 Notrated a2

a3 Motrated Intensity Name o Priority
(@ Not rated

€ DI () Outstanding 100 00% | m—

a5 Mot rated (O Excellent 86.20% mm——
(O Very Good - fest 69.00% |m—
(O Good to Very Good 55.60% -
(O Good 46.70% [
() Moderate to Good 36.00%
(O Moderate 2590% I
OATad 400% 1
(C)None 0.00%

() Abstain
P JeTI=T R m—
With respect to Single graphical,
which of the two alternatives below is more preferable @ o=

Single graphical Q

)

1 1 2 03 573

Abstain

f ’ a3 #
1T Single graphical (# @ Comment

----------- al

Model Wording

We added singular and plural terminologies for Objectives and Alternatives as a model setting. Previously, the model wording
was defined from the Judgments options page and had only a "plural” form.

This can be done on the Define Model > Description/Details page:
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& MANAGE MODELS o=V eli/oH ECOLLECTINPUT| = SYNTHESIZE ‘ & ALLOCATE ‘ & DASHBOARDS | &= REPORTS

E»Add page to...

Model Description

&JTeamTime™ Brainstorming

[ Description

[# Model Details

Model Assumptions:

7"STeamTime™ Mind Map Access code * | 9591-9321 & @ Get Links. .
O Review / Refine Model + | Available by access code
E= Alternatives
Model Timeline Begins On:
£ Alternative Clusters ¢ 8
I, Objectives Model Timeline Ends On- ]

£ Contributions
@ Information Documents
2e2Define participants & roles
%‘-Parﬂcipants
& Participant Roles
B Set Measurement Options

Model Stafistic:  Alternatives count: 16
Objectives count: 22, terminal Objectives: 15
Participants count: 8

DB version: 1.1.55
Created. 1/27/2022 4:37:11 AM

Last modified: 2/8/2022 7:23:55 AM

4laMeasurement Methods
Define Insight questionnaires

Pre-Survey

Post-Survey

£ Surveys settings

Model Wording

Alternative:

Objective:

alternative Alternatives:  alternatives

objective Objectives:  objectives

You can also change the wording from the left navigation menu and landing page (right-click):

& MANAGE MODELS [ DEFINE‘MODEL COLLECTINPUT | |= SYNTHESIZE | 4ls ALLOCATE | @ DASHBOARDS | = REPORTS

x

Model Description
[ Description/Details

S JTeamTime ™ Brainstorming

E= Alternatives

- Objectives

£5 Contributions
@ Information Documents
2e2Define participants & roles
2s2Participants
@@ Participant Roles
BnSet Measurement Options
&laMeasurement Methods
B Define Insight quastionnaires
B Pre-Survey
B Post-Survey

Portfolio Canvas

& DEFINE MODEL

Define model is where we "structure” & decision madel by identifying Objectives (criteria) and Alternatives as well
visit our HELP SECTION.

MODEL DESCRIPTION FOR 'GOAL: OPTIMIZE IT PORTFOLIO TO IMPROVE PERFORMAN

D Description/Details

:':] TeamTime™ Brainstorming

REVIEW / REFINE MODEL

®
- Chang ng to -]

""" @ Aternatives

0O Projects
O Candidates @
# Edit model wording X

£3 Contributions

o Information Documents

right-click«context:imenu
N

We improved the Resource Aligner Portfolio View which is now namedPortfolio Canvas. The new Portfolio Canvas is more
optimized for larger models and has additional improvements, such as freezing the column heading and the alternatives column

for better viewing.
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¥ Resource Allocation for scenario "Default Scenario™
Portfolio Assessment =T . S Cace i
. seall | Ignorea ase Case includes
2 Portfolio Canvas. ® Ignore: 2
& Eficient Frontier P e ots Groups: »»
 Strategic Buckets () Cblom Constains 2 -»
[ Visualizations Croups
| Scenario Comparisons —
Portfolio Constraints | Drag a column header here to group by that column o Auto-solve Default Scenario - B % Risks~ & Downlad~ = More.~ @ Legend & | Q Search Hide ignored columns
i Custom Consiraints 1 Info | Atternatives Funded | CostofDelay — | E.Benefit — Risk P.Success — P.Failure —  Duration WSJF Groups. Partial Min % Must MustNot | Custom Co
= Dependencies
Network
f Time Periods Duratic Y
3 Time Periods Durations 1 © AS/400 Replacements Yes 06482 05918 00564 09130 0.0870 990.00 06548 5
5 Time Periods Results — = -
& Groups 2« Cisco Routers Yes 07679 07487 00192 0.9750 0.0250 500.00 15358 #1 2
£ Funding Pools 3 O Customer Service Call Center Yes 07312 06917 00395 0.9460 0.0540 980.00 07461 2
| Summary 4 ©  Desktop Replacements 05870 05818 00053 09910 0.0090 80000 07338 #2 5
EDM”"E' Specification 5 © EMC Symmetix Yes 06674 05920 00754 0.8870 04130 | 4.220.00 01581 3
#2Relevant Constraints — - -
6 Firewall and Antivirus Licenses Yes 06570 0.6570 0.0000 1.0000 0.0000 120.00 54754 #1 1
7 © Iron Mountain Backup Senvice Yes 06742 06729 00013 09980 00020 430.00 15680 0
8 ©  Laptop Replacements 03819 03693 00126 09670 00330 134000 02850 | #2 1
9 @ Mobile Workforce Pocket PCs Yes 04237 02991 0.1246 0.7060 0.2940 230.00 18421 #2 0
10 © Oracle 9i Upgrade Yes 07470 0B4TT 0099 08670 01330] | 1890.00 03952 1
11 © PeopleSoft Upgrade Yes 05799 05005 00795 08630 01370 1.670.00 03473 1
12 © Plumtree Corporate Portal Yes 1.0000 0.8860 0.1140 0.8860 0.1140 1,345.00 07435 #1 1
13 ©  ProServe System Upgrade 07213 06289 00923 08720 0.1280] [ 2300.00 0313 1
14| @ | Sales Force Laptops 06792 06446 0.0346 0.9490 0.0510 150.00 45281 #2 v 2
15 O SRDF Site/Service Yes 05749 05295 0.0454 09210 0.0790 3,440.00 0.1671 1
16 ©  Thin Client Implementation 09269 07777 01492 08390 01610] [ 2,100.00 04414 #1 2
« »
Funded: 1 74715 6.8169 15,815.00 1
Total: 16 10.7678 9.8191 22,505.00 2
Min:
Max: x

The New Portfolio Canvas panel in the Dashboard was also improved. You can now update the Allocation Settings (Ignore

options, Scenario, Solve options, etc.) on the panel.

&= MANAGE MODELS

All

4+ Create & O @ New panel = = Panels_. ~ E O Goal: Optimize IT... ~ | 0.00 -

&= DEFINE MODEL | B3 COLLECTINPUT | [E SYNTHESIZE | &6 ALLOCATE /] DASHB‘OARDS = REPORTS |

% of Maximum

All

vuu e v
COVERALL 50% f /‘
3.52%
]
40% Z
g s
30% S ®l @
< &
5 | 8
20% £ ]
SE N
ol =
10% 5 .?o__. ?
c s |
0% 2 40 ?
5.76% 9.5
5.23%
© Portfolio Canvas © Information f
- Use all  Ignore all Base Case includes: Your custom text
Budget Limit Expected Beneft lgnore: g ) )
16,000.00 = 6.8169 [ — Wusts Funding Pools Groups pt
o — - = 9 429 Must Nots Risks
Funded Co= Base Case Maxm Custom Constraints 2 Time Periods )
15,815.00 9.8191 Dependencias Min
Groups Max *
So— 4
g Draga column header here to group by that column v Auto-solve Default Scenaric - & |Q Search. H 4
ID | Info Alternatives Funded Costof Del: E. Benefit — Risk P. Success — P. Failure Duration Wi -
1 AS/400 Replacements Yes 0.6482 0.5918 0.0564 0.9130 0.0870 990.00 - /
2 Cisco Routers Yes 0.7679 0.7487 0.0192 09750 0.0250 500.00 ,
3 @  Customer Servics Call Centar Yes n7312 06917 0 0395 n q4R0 N N&RAN qan nn 3
‘ :
Funded: 11 7.4715 6.8169 15,815.00
Total: 16 10.7678 9.8191 22,505.00 J
Min:
Max: ;
L

You can also toggle the Benefit column to Cost of Delay (CoD), and show the corresponding ratio.

If Benefit is selected, we display the Cost and Benefit-cost ratio columns, and if CoD is selected we rename the corresponding

columns to Duration and WSJF (Weighted Shortest Job First).
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Groups »» Max |
[k Drag a column he 0 group by that colum [ZRELITN || Auto-soive  Default Scenario M % Risks* % Download~ = More..> @ Llegend & |Q Search
D Info Alternatives Funded Cost of Delay E. Benefit — Risk P. Success — P. Failure 1 Duration "WSJF Groups Partial Min
A Copy Column
1 © AS/400 Replacements Yes 0.6482 EB‘*"W‘C"SWD““ o) 19130 0087 Siris 665
2 © Cisco Routers Yes 0.7679 0.7487 0.0192 0.9750 0.0250 500.00 15358 #1
3 © Customer Service Call Center Yes 0.7312 06917 0.039%% 0.9460 0.0540 980.00 0.7461
4 @  Desktop Replacements 0.5870 0.5818 0.0053 0.9910 0.0090 800.00 0.7338 | #2
5 @ EMC Symmetrix Yes 0.6674 05920 _ 0.0754 0.8870 0.1130 4,220.00 0.1581
€& ©  Firewall and Antivirus Licenses Yes 0.6570 0.6570 0.0000 1.0000 0.0000 120.00 5.4754 #1
7 ©  lron Mountain Backup Service Yes 06742 06729 0.0013 0.9980 0.0020 430.00 1.5680
8 @  Laptop Replacements 0.3819 03693 00126 0.9670 0.0330 1,340.00 02850 | #2
9 @  Mobile Workforce Pocket PCs Yes 04237 02991 01246 0.7060 0.2940 230.00 18421 #2
Comparion now has two views for the Contributions settings: by Alternatives and by Objectives.
# MANAGE MODELS DEFINE‘MCIDEL ECOLLECTINPUT‘ & SYNTHESIZE ‘ & ALLOCATE ‘ @ DASHBOARDS ‘ & REPORTS ‘ [BsAdd page to... ¥ Reload @ On-ine gglock @ [E)Snapshots jij
x Contributions of 0
»N‘D”;i[c’::z::;;a”s [ by Objectives  Selectall  Deselectall | Show Altemative Attributes -
S TeamTime™ Brainstorming | Goal: Optimize IT Portfolio To Improve Performance
) Review / Refine Model | Leverage Knowledge | Improve Organizational Efficiency | Maintain Serviceability | Minimize Risks | Financials
ectives endorParner  Customer  Intenal P10 o I ansge | o ioabiity | Rosponsh - & | Readiness aximize | Maximize
coss | ocmlSonico Ao | cidanchs | Fowar | ey | Rocsens | USSP ROspoiiensst RO 1ot | vonor | s | O
information Documents. v ] V| V| 2 v
Define pavnic\pams & roles | 01AS/400 Replacements = ] 2 2 Y] v ~ - v | v % v v
artiipants
PR 102 Cisco Routers & - - o - g = = 9 5 G o = &z
@St Measurement Options. |03 Customer Service Call Ce v | v v ] % v v v v v o v &
leMeasurement Methods 04 Desktop Replacements v v/ v v v/ v v v v/ % v v v v
' Define Insight questionnaires ~ 05 EMC Symmetrix v v v v v v v & v v v v - >
B Pre-sumey e
o] Post-Survey 06 Firewall and Antivirus Lice. v V| v v V| v v v v v| v v v| v
~ 07 Iron Mountain Backup Ser... Ca v v 2 V| v v v v V| v v | V|
< ~/08 Laptop Replacements v v v v v v v v v v % % v v
09 Mobile Workforce Pocket v v| v v v| v v v v v| v v v| v
/10 Oracle 9i Upgrade v v v v v v v - v v v v - &
~ 11 PeopleSoft Upgrade v | v v v % v - v v 5 & ] ]
12 Plumtree Corporate Portal v v v v v v v v v v % % v v
+ 13 ProServe System Upgrade v v v v v v v & v v v v Y] =
|14 Sales Force Laptops v v v v v % v - v v v v - ™
15 SRDF Site/Service v V| v v V| v v v V| v| v v V| v
+ 16 Thin Client Implementation v v v v v| v v v v v| v v v v

Time Period Dependencies

The Dependencies screen has been improved and additional dependencies were added for Time Periods.

& MANAGE MODELS

& DEFINE MODEL ‘ E COLLECT INPUT ‘ = SYNTHESIZE gacREe@ NI @ DASHBOARDS ‘ = REPORTS |
r

k= Portfolio Assessment

2 Portfolic Canvas

& Efficient Frontier

i Strategic Buckets

[ Visualizations

k= Scenario Comparisons
2 Portfolio Constraints

5 Custom Constraints

T, Time Periods Durations
T, Time Periods Results
& Groups
£ Funding Pools

[ Summary
[ Model Specification

& Relevant Constraints

Scenario

D{Tult Scenario

Alternatives

1. AS/400 Replacements

2. Cisco Routers

3. Customer Service Call Center
4 Desktop Replacements

5 EMC Symmetrix

6. Firewall and Antivirus Licenses
7. Iron Mountain Backup Service
2 Laptop Replacements

9. Mobile Workforce Pocket PCs

10. Oracle 8 Upgrade

A

11. PeopleSoft Upgrade

12. Plumtree Corporate Portal
13. ProServe System Upgrade
14. Sales Force Laptops

15. SRDF Site/Service

16. Thin Client Implementation

- EER
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List View

1.4
Repla

Depends On (Can be concurrent) - || & ClearAl

pends On (Can be concurrent) for scenario "Default Scenario”

D Depends On (Non-concurrent) 4. Desktop 5. EMC Symmetrix
D Depends On (Start at the same time} Ry iEnErs

D Depends On (End at the same time)

M Mutually Dependent (Start at the same time}
M Mutually Dependent (End at the same time})
M Mutually Dependent

X Mutually Exclusive

& Clear Cell

D (Non-concurrent]

6. Firewall and
Antivirus Licenses



Expert Choice Comparion® Help Document

Dashboard New Panels

Additional panels: Contributions, Information Documents, Participant Roles, Evaluation Progress, and Datagrid are now available
in the Dashboard!

Add dashboard panel X

Panel type: * Title: *

I Objectives Hierarchy ) Mind Map

- Note:

E2 Alternatives List

SJAlternatives’ Pros and Cons

£7 Contributions p
® Information Documents ® Show title/note ,
@ Participant Roles Panel size.

282 Participants List 2x6

Collect input

#= Evaluation progress

2 Data Grid Background:

- =5 -
Add Cancel

Pairwise Verbal Scale Ratio

The Project Manager can now display the verbal ratio (x3, x5, x7, x9) for single and multi-pairwise evaluation.

© 2019 Expert Choice. All Rights Reserved
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Using the list below, select the bar on the scale to indicate which shape is larger and by how much.

® <

EICIRCLEA EITRIANGLEER '™

o B

Ex w5 5 It Ex  Extremely ~ an order of magnitude (9 or 10 fo 1) or more

VS | Very Strongly ~ 7 times
S | Strongly ~ 5 times

M | Moderately ~ 3 times
Eq | Equal ~ equal

CIRCLEA

TRIANGLE B

SQUARE C .... #*
DIAMOND D .. $t
CIRCLEA ...... ®
TRIANGLE B ... ®

m ,F“Liﬂ,_ﬂrwm_f ey ST A

This option can be turned on from the Set Measurement Options > Participant display options:
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& MANAGE MODELS

x

= Evaluation status
B Anytime Evaluation
5% Send Invitations
B Collect my input
B Collect my input (responsive)
B Data Grid
2s2TeamTime™ Evaluation
2e2Select Participants
B Invite Participants
@ Start/Stop Meeting

5 DEFINE MODEL zTeoJENIallINI M |= SYNTHESIZE | 46 ALLOCATE | @ DASHBOARDS EREPORTS|
'y

Participant display options ~ ~

mieEnneuare nesuils

() Hide

(O Individual (AnyTime Evaluation only)

(O Actual Sizes (real@experichoice.com) &
@) Bath

[ Display "expected value' if applicable

] Show index

Show Normalization option

Show priority bars

Intermediate results sorting
(@ No sorting

Sort by name
ort by individual priority

(O Sort by combined priority

"“\_*’,\....“\"‘“

4 Show welcome page Edit...
4 Show thank you page Edit...
[T show "Reward" page instead when participant completes all their judgments Edit...

Show full objective path: (@ Never () Always () Auto-collapse

Question Text-to-Speech: () Disabled () Auto-play (when available) @ Play on demand

Show inconsistency ratio (An inconsistency ratio cannot be computed if there are more than fifteen ele

Show information documents
Display information documents as frame (uncheck fo display as fooltip)
[T Hide information documents captions
Auto-fit information document images
[ show/allow comments entry
Use combined input sources for individual results
i i t made
Show verbal pairwise scale with ratios

Sensitivity analysis

[T Display dynamic analysis

[T Display gradient analysis

[ Display performance analysis

Which results do you want to use in the sensitivity analysis?
() Individual
(@) Combined

(
d
f

Pairwise No. of Diagonal setting in the evaluation

The Project Manager can now update the no. of diagonals (All diagonals, 2 diagonals, 1 diagonal) for multi-pairwise graphical

and verbal from the evaluation screen.

Changes made by the Project Manager will be saved on the model and applied to the evaluators.
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& MANAGE MODELS | i DEFINE MODEL [T REea iUVl |= SYNTHESIZE | 86 ALLOCATE | @ DASHBOARDS | & REPORTS 'Reload @ On-ine @@
i

Evaluate the relative importance with respect to Goal: Optimize IT Portfolio To Improve Performance of the two objectives in each pair below @ ox

&)

£ Leverage Knowledge = Goal: Optimize IT Portfolio To... / B Improve Organizational Efficiency &

This sample model reviews

how an organization might
prioritize, optimize, and select

its Information Technology -

[l Leverage Knowledge WRT Goal Optimize IT. . &
WRT goal is important

Ex ¥S S M Eq M S VS Ex

Improve Organizational Efficiency [ ] % Maintain Serviceability Eq_ Equal ~ equal

Maintain Serviceability ........ =
[ [ [ [[][] *

B Improve Organizat.. WRT Goal- Optimize IT... &

- Ex Extremely ~ an order of magnitude (9 or 10 to 1) or more

Leverage Knowledge ..... ® Improve Organizational Efficiency V& Very Strongly ~ 7 times

S Strongly ~ 5 times
M  Moderately ~ 3 times

All judgments -
All judgments

2 diagonals
1 diagonal

Leverage Knowledge ...... " Maintain Serviceability \

Improve Organizational Efficiency EEEEEEE ®

B AP s dB Bt s tr e P A s o g gpits_pn . g P e P P ot il a0 o gt Py

Collaborative Brainstorming Whiteboard Access

Comparion now allows existing users of a model to access the Collaborative Brainstorming Whiteboard even if the meeting has

not been started by the Project Manager.

This can be enabled by the Project Manager in the Define Model > Model Details page:

& MANAGE MODELS DEFINE‘MODEL B3 COLLECT INPUT ‘ = SYNTHESIZE ‘ &s ALLOCATE ‘ @ DASHBOARDS | = REPORTS

x
Model Description

& JTeamTime™ Brainstorming
© Review / Refine Model
£z Alternatives
5 Objectives
£5 Contributions
@ Information Documents
2s2Define participants & roles
Zafparticipants Model Assumptions:

i Participant Roles Access code: *
% Set Measurement Options

&leMeasurement Methods
B Define Insight questionnaires

B Description [ Model Details

4327-3627 & @ Getlinks...

+ | Whiteboard available

B Pre-Survey Model Timeline Bagins On:
B Post-Survey
Model Timeline Ends On:

< WModel Statistic:

DE version:
Created:

Last modified:

Alternatives count: 16
Objectives count 22, terminal Objectives: 15
Participants count: &

1.1.55
TMTI2023 3:38:50 AM

10/9/2023 6:25:46 AM

The users will be able to open the CS whiteboard from the Models list as shown below (not by using the CS link):
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Expert Cholce .
‘_, : com pa rion Workgroup: - : : ; Marcia ~
oy Dr that column Q, Search 2]
* Model name On-line Status
i Available,

IT Portfolio Optimization

3 0pen Whiteboard [Vhiteboard available
[t

B Collect my input ™/ Not available

Note: The model must be online for whiteboard access to be allowed.

Information Documents Enhancements
Information Documents are now viewable from the Synthesize screens (Charts and Sensitivities).
Information documents can be opened as a new pop-out window:

Alternative Priorities

AS/400 Replacements

AS/400 Replacements 73.94%
i Cisco Routers
B Customer Service Call Center
~ Cisco Routers 79.44% Desktop Replacements
e EMC Symmetrix
% customer Service Call Center 69.84% Firewall and Antivirus Licenses
6 Iron Mountain Backup Service
:° Deskiop Replacements 7431% kﬁgﬁg Ezfﬁgizegéiket bes
° Oracle 9i Upgrade
5 EMC Symmetrix 91.23% M PeopleSoft Upgrade
5 W Plumtree Corporate Portal
% Firewall and Antivirus Licenses 65.15% W Proserve System Upgrade

M Sales Force Laptops
M SROF Site/Service

.

PR

e e e e

[@ Show Information Documents

@t Custom Color

Bl € Description/Defirition for "Thin Client Implementation® [IT Portfolio Optimization] —Comparion® - Google Chrome

& qa.expertchoice.com,

i % Description/Definition for "Thin Client Implementation”

Project Sponsor Name
Project Manager Name

i 76%

(Note: The Project Manager can add new information documents, but if the alternative or the objective already has existing
infodocs, you will need to edit this page at Define Model > Alternatives / Objectives, Information Documents or Evaluation pages).

Information documents can also displayed as tooltips (plain text).

60.80%
60.74%
65.69%

T lient Implementation

Marcia Sponsor Name

t Manager Name

We have also added the same pop-out window to open information documents from the Objectives and Alternatives page.
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MANAGE MODELS I:ﬁi“i;a:ﬁl COLLECTINPUT | SYNTHESIZE ALLOCATE‘ DASHBOARDS‘ REPORTS

EEcoad @i

Hierarchy View - Expand All ID: | None

Collapse Al [+ JENLR4  # Edit

Goal: Optimize

Model Description
[ Description/Details

& JTeamTime™ Brainstor - i T:ls{zﬂg 1
© Review / Refine Model Performance

=% Alternatives
£3 Co
@ Info

2s2Define

=
. Goal: Optimize IT Portfolio To
Improve Performance

I [0 )
€ Description/Definition for "Goal: Optimize IT Portfolio To Improve Performance™ [IT Portfolio Optimization] — Comparion® - Google Chrome

@ qa.expertchoice.com

= | v| Show Alternatives $ St

Goal: Optimize IT Portfolio To Improve Performance

This sample model reviews how an organization might
prioritize, optimize, and select its Information
Technology investments. Note that there were

i ic ontributing judgments and

heir process for creating
ent as follows:

2e2Pary d and defined its objectives
& Par Description/Definition for "Goal: Optimize IT Portfolio To Improve Performance” ity Diagramming module
2550t Mg This sample model reviews how an organization might prioritize, optimize, and select its Information Technology live importance of their
oM investments. Note that there were multiple participants contributing judgments and expertise to the decision. Their process lomparison (available from
. Y for creating and evaluating the model went as follows: 5
B Define jtton 2/ ). During pairwise
B Pre{ 1. The group first structured and defined its objectives using Expert Choice's Affinity Diagramming module and Pro/Con their inconsistencies using
Bi Pos| capabilities. View _
2. They measured the relative importance of their objectives using pairwise comparison (available from the Pairwise ensure the accuracy of their
Individuals button '21). During pairwise comparison, they checked their inconsistencies using EC 11s new Inconsistecies yone from gaming the
View (View=>Inconsistencies) to ensure the accuracy of their judgments and to avoid anyone from gaming the system. tives. the aroup scored
3. After prioritizing their objectives, the group scored the technology investments using absolute scales including rating 5 using ‘ahsoﬂna gcal es
scales and utility curves, all available from the DataGrid . utility curves, all available
4. They reviewed their priorities to confirm the results, and then tested the reliability of the results using Sensitivity
Analysis.
5. They then optimized the portfolio for benefit and constrained with various types of constraints using Expert Choice's ”ﬂesof :EGO:':J;T;;:S“IE‘
Resource Aligner (available from the Data Grid using the Resource Aligner button & ). While modeling their constraints,
they also input project risk figures produced in a separate EC hierarchy. ) _ it de3 n
6. Lastly, they generated powerful reports using the reporting capabilities of EC 11 and the EC Resource Aligner. Their -
O Objective O Alternative
Shortcuts @D Advanced mode is ON ESn 10 008

©2007-2023 Expert Choice. Inc. All Riohts Reserved

MANAGE MODELS I:ﬁi:i;a:ﬁl COLLECTINPUT | SYNTHESIZE | ALLOCATE | DASHBOARDS | REPORTS

Bcoaib @i

[E Attributes * Sort ~

AN © Add -
Model Description
[) Description/Details @ Z

~
*= | Thin Client Implementation
£TeamTime™ Brainstor...

© Review / Refine Mode! Index Infor... Alernatives
bl Project Sponsor Name
EE Altematives 01/ @  AS/400 Replacements Project Manager Name
<k Objectives € Description/Definition for "Thin Client Implementation® [IT Portfolic Optimization] — Comparion® - Google Chrome - ]
£5 Contributions

. & ga.expertchoice.com
@ Information Docul qa.exp

s2Define participants &

Description/Definition for "Thin Client Implementation”

2e2Participants
& Participant Roles
¥pSet Measurement O

Project Sponsor Name
Project Manager Name

alaMeasurement Mel
B Define Insight questi

B Pre-Survey

1] Post-Survey

Edit description

View description

& Shortcuts @ Advanced mode is ON

Version: 6.13 001

@ 2007-2023 Expert Choice. Inc. All Rights Reserved

Disabled Alternatives Fixes and Enhancements

Disabled Alternatives are now excluded from the evaluation and will no longer show up on the results screens.
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& MANAGE MODELS Sl leh]IN OLLECT INPUT | = SYNTHESIZE | &t ALLOCATE | @ DASHBOARDS | & REPORTS 1
_
x @ Add ~ Attributes % Sort -
@ Model Description

[) Description/Details =]
£JTeamTime™ Brainstorming

Q
[

© Review / Refine Model Index Infor... Alternatives E Disabled?
i 01 @  AS/400 Replacements ~
5 Objectives i 02 @  CiscoRouters
gi::::z:‘;:n;owmems 03 Customer Service Call Center v
2s2Define participants & roles 04 Deskiop Replacements

2elParticipants. H 05 EMC Symmetrix
@@ Participant Roles

. ) 06 Firewall and Antivirus Licenses
ST rr——

D Alternative Name All Participants
2 Cisco Routers 61%

4 Desktop Replacements _48.43%

5 EMC Symmetrix 52.78%

B Firewall and Antivirus Licenses 51.96%

7 Iron Mountain Backup Service 53.32%

Disabled alternatives are not editable on the Information Documents and Participant Roles screens. In the Contributions screen,
an option is added to show/hide the disabled alternatives.

& MANAGE MODELS _ DEFINE‘MODEL E3 COLLECT INPUT ‘ = SYNTHESIZE | &6 ALLOCATE ‘ @ DASHBOARDS | & REPORTS B> Add pag

¥ jibuti jves to Objectives
@ Model Description & ILCUETNTEM by Objectives  Selectall  Deselect all Show Alternative Attribtes [v| Show disabled Alternatives
D) Description/Details

P ¥ Brai ; | Goal: Optimize IT Portfolio To Improve Performance
£ TeamTime™ Brainstorming Goal: Optimize IT Portfolio To | Perfi
ORsview / Refine Model 8 Leverage Knowledge | Improve Organizational Efficiency & Maintain Serviceability
£ Alternatives Alternatives
Vendor/Partner Customer nternal | TIProve ﬁzﬁ;ﬁfg MPIOVE Manage . . -
&3 Contributions A““-ESS Ac““sfe“‘”:e ACC-“S Efficiencies Power Markst R%"-‘"“’S - " -
@ Information Documents L L L
2a2Define participants & roles
N 01 AS/400 Replacements
2eZParticipants.
& Paricipant Rolss 102 Cisco Routers v - v v % v - v v %
#5Set Measurement Options 03 Customer Service Call Ce
&leMeasurement Methods | 04 Desktop Replacements v v v v v v v v v v
B3 Define Insight questionnaires T - - - - - - S - - -
B Pre-Survey
B Postsuney | 06 Firewall and Antivirus Lice. v v v v % v - - v 5
| 07 Iron Mountain Backup Ser.. v v v v v v v v v v
< [~ 08 Laptop Replacements. v v v v v v v v v -
00 Mahila Warkfarra Pnarkat v | v ) 4 v | “ v i

Model Linkage

Display the list of linked or associated models:
e Save As (Copied from)

o Default Option Set Used
e Associated Risk Model
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wkgroup:

omparion model: IT Portfolio Optimization Demonstration Model @it

ECTINPUT | |= SYNTHESIZE

4B ALLOCATE

.d DO New Model @ New from Template

-

ition Model 1.1.46

" Model (4) (2)

Collect input Settings

Linked Models

Risk associated model: -

Risk_IT Portfolioc Optimization Demonstration Model (4) (2) Associated Risk @

Copied from model: -

IT Portfolio Optimization Demonstration Model (4) (2) Regular @
| Models History | Close

All the Collect input settings are now available on a single page:

& MANAGE MODELS | & DEFINE MODEL (TR0 IIZaR LIl (= SYNTHESIZE | & ALLOCATE ‘ @ DASHBOARDS | & REPORTS ¢
i
¥ Set Measurement Optio#

‘= Evaluation status

t Measurement Options
B Anytime Evaluation
5% Send Invitations
@ Collect my input
@ Collect my input (responsive)
= Data Grid
ie2TeamTime™ Evaluation
2s2Select Parlicipants
= Invite Participants
& Start/Stop Meeting

‘\u—’\,"*w

o

Judgment Options i
Judgment Options
EvalllateAlI?

Evaluation settings
Participant display optiens Default measus
Surveys settings "

‘When prioritizi

Evaluation Judgment Count

We added the judgment count per page for multi-evaluations, this helps the evaluators to see if there are any missed judgments.

The overall judgment count is also updated as the evaluator enters/deletes judgment (on the previous version, the page needs to
be reloaded first before the count will get updated).
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AS/400 Replacements None 0.00% Sales Force Laptops
Cisco Routers Marginal - 32.31% Intensity Name Priority
Customer Service Call Center Poor [ ] 10.44% @ Not rated
() Excellent 100.00% | —

Desktop Replacements MNone 0.00% (O Very Good 72 755
EMC Symmetrix Mone 0.00% () Good 44 22% mmm
Firewall and Antivirus Licenses Poor [ ] 10.44% Q Marginal 32.31% .

. . (O Poor 10.44% 1
Iron Mountain Backup Service Mone 0.00% O None 0.00%
Laptop Replacements Mone 0.00% (O Direct Value |
Mobile Workforce Pocket PCs Foor 1 10.44%
Oracle 9i Upgrade Good — 44.27%
PeopleSoft Upgrade Marginal Jr— 3231%
Plumtree Corporate Portal Excellent I 100.00%
ProServe System Upgrade Good — 44.27%
Sales Force Laptops Mot rated
SRDF Site/Service Mot rated
Thin Client Implementation Mot rated

33 ] 34 | 35| 36 |... 96

[ view
Evaluated: 259/262 #Judgmenis: 13/16

W s Y S N W e

Show the %Effectiveness on the Time Period Results screen

Show the calculated %Effectiveness on the Time period results page:

& MANAGE MODELS | s DEFINE MODEL | E3 COLLECT INPUT | = SYNTHESIZE gacY\RKew. & DASHBOARDS | = REPORTS |
x Effectiveness: Scenario: Period format:  Period step: Start year:
Solve 69 54% W v 2023 »
L Portfolio Assessment - Default Scenario Years I:I

2 Portfolio Canvas

1D Alternatives Duration V| 2023(1) BIEUEE ARG
#2 Efficient Frontier
# Strategic Buckets 1 (®HK © AS/400 Replacements Iﬂl 990 00
5 Vi, Dizations 2 @K O Cisco Routers
L= Scenario Comparisons 3 (®Eg Y Customer Service Call Center
% Portfolio Constraints 4 (@I © Deskiop Replacements
8 Custom Constraints 5@ 0 EMC Symmetrix
= Dependenciss 6 ¢®ik O Firewall and Antivirus Licenses
5 Time Periods Durations 7 (@ © Iron Mountain Backup Service
S (@I © Laptop Replacements
f S’O'jf’s . 9 Ik 0 Mobie Worklorce Pocket PCs [ 230,00

Pagination when adding Alternatives

We added pagination when adding alternatives, this is helpful when pasting many items that can cause the application to hang
up.
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Add Alternatives X

+ W
Alternatives Description
[ ]
10 15 20 25 50 100 500 1000 ¢ M1 )
v Save & Cancel

Reset Zoom on the Hierarchical Pie chart

Added an option to reset the zoom ratio for the Hierarchical pie chart.

Chart Type JFont Size — P Sorting metho
terarchcalpie - ¢ >//@/419 s Dot - suca o [T Sort None

Reset zoom ratio

whjective Priorities

Marcia
Local Global

1.22% Resources
1.22% Responsivensss = —
20.49%  20.49% 6 08% Maintain... Bl .

28.09% 1 ST8%  gaw Scaleabilty [T~
2552% | 523%

4638% | 9.5%
3826%  38.26%
926% | 3.54%
15.45% |  5.91% Minimiza
24.49% | 937% Risks
50.8% | 19.44%
6.08%  6.08%
60% | 3.65%
20% | 1.22%
20% | 122%
2162%  21.62%
25% | 5.4%
5% 16.21%
66.67% | 10.81%

s i, . P

M 4.52% Maximize. .

Goal:
Optimize IT Porifolio
To Improve
Performance

anoudiuy

Minor Dashboard Enhancements

o Allow column resizing on the Alternatives and Objectives Grid
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© Alternatives Grid O % I @Objectives Grid

Projects Priorities Objectives

s All Participants
M International Trash Trap Network d 3551% = [l Drastic reduction in plastic waste residing in and reaching the oc
Ocean Climate Policy 26.76% Manage financial resources

W Ocean Justice Discourse 9.81% M Organizing fundraising at the local level

Il Ocean justice Community Grants: 21.50% M Encouraging usage of largescale financial instruments

W Ocean Justice Advacacy Group 26.50% [ Administer international cleanup efforts

[l Confronting Climate Change 28.23% [l Interface with international policy makers

M Protecting Florida 63.19% M Interface at the local level

M Smart Ocean Planning 31.12% Il Adopting international standards

. O

© Dynamic sensitivity analysis @ Performance sensitivity analysis

All Participants All Participants Objectives J*

Objectives |= Projects I . § = %
Administer international cleanup efforts ~ 34.41% International Coastal Cleanup 7.37% = 1 5 ¢ [ )
sa 2 T g A0 Laoss

Goal: Optimize IT Portfolio To Improve Performance
Leverage Knowledge
Vendor/Partner Access
Customer Access/Service
Internal Access
Improve Organizational Efficiency
Improve Service Efficiencies
Leverage Purchasing Power
Improve Time to Market
Manage Resources
Maintain Serviceability
Scaleability
Responsiveness new
Resources
Minimize Risks
Leverage Proven Technology
Ensure Readiness
Business
Vendor

We removed the All tab on the measurement method screen:

© 2019 Expert Choice. All Rights Reserved

o Disable the row selection (blue highlight) on the Objectives and Alternatives Grid

B Goal: Optimize T Portfolio To Improve Performance

Leverage Knowledge

Vendor/Partner Access
Customer Access/Service
Internal Access
Improve Organizational Efficiency
Improve Service Efficiencies
Leverage Purchasing Power
Improve Time to Market
Manage Resources
Maintain Serviceability
Scaleability
Responsiveness
Resources

old

Minimize Risks
Leverage Proven Technology
Ensure Readiness

‘Vendor

Business

Simplified the Measurement Methods screen
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B MANAGE MODELS a3V oS E8 COLLECT INPUT | Ll SYNTHESIZE ‘ &3 ALLOCATE | & DASHBOARDS | & REPORTS |

©) Define Model

L ERIROVEI o For Alternatives = Al
[ Description/Details

& JTeamTime™ Brainstorming Measure Alternatives With Respect To

© Review / Refine Model

- Goal- Optimize IT Portfolio To Improve Performance
ES Alternatives

<& Objectives Leverage Knowledge This is a long objective name

&7 Contributions Vendor/Partner Access This is a long alternative name
© information Documents Customer Access/Service
saiDefine participants & roles
sBiParticipants Internal Access
& Participant Roles Improve Organizational

£ Participant display options
£ Evaluation setiings Improve Service Efficiencies

) <
x5St Measurement Options Leverage Purchasing Power
&léMeasurement Methods ®
Improve Time to Market
€2 Judgment Options
Define Insight questionnaires Manage Resources

P
[

Measuremef

Measurement Type

Default: Rating Scale Me?
4
4
Rating Scale ~ Scale
Rating Scale ~ Scale .
4
Rating Scale ~ Scalf
L]
1
Rating Scale ~ Scaled
Rating Scale ~ Scalf'.
Rating Scale ~ Scalg
Rating Scale v ScaIJ

/] Pre-Suwez » 4 ~ J'WWM"* AWM ‘1

Grid, Charts, and Sensitivities Enhancements

e The Grid alternative bars are now optional and the colors are based on the color settings

Show bar chart

Normalize Options: @ Ideal @ Al

i i o
v | Unnormalized v OII}istrit}lL.lti\.reO.’-\IF’DlndudeIdealaltermtl"re.CIS

IT Portfolio Optimization
Alternatives Grid

ID Alternative Name All Participants
2 Cisco Routers 61%
4 Desktop Replacements 46.43%
5 EMC Symmetrix 52.78%
B Firewall and Antivirus Licenses 51.96%
7 Iron Mountain Backup Service 53.32%
8 Laptop Replacements 30.21%
9 Mobile Workforce Pocket PCs 3351%
10 Oracle 9i Upgrade 59.08%
" PeopleScoft Upgrade _45.86%
12 Plumtree Corporate Portal 79.09%
13 ProServe System Upgrade 57.04%

e Added labels on Charts dropdowns
e Improved the heading and labels (increased font size and spacing)
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Chart Type = [ mode —
Columns - | gz Components | oz of Maximum .

s u Local  Global

! -
Shew all alternatives M

&R Grid View 14 ﬁ:fau\t -

Alternative Priorities

PR Looen |

Goal: Optimize IT Portfolio To | Per._. Cisco Routers 76.79%
Deskiop bosmammers T
Leverage Knowledge EMC Symmetrix 66.74%
Vendor/Partner Access Firewall and Antivirus Licenses 65.70%
Iron Mountain Backup Service 67.42%
Customer Access/Service Laptop Replacements [ 38 15%
Internal Access. Mobile Workforce Pocket PCs I, 42.37%
| Oraanizational Efict. Oracle 9i Upgrade 7470%
mprove Organizational Efficiency PeopleSoft Upgrade 57 99%
Improve Service Efficiencies Plumtree Corporate Portal 13 100.00%
5 ProServe System Upgrade 3%
Leverage Purchasing Power ‘Sales Force Laptops | 67 92%
Improve Time to Market SRDF Site/Service I — 57 49%
Thin Client Implementation 9269%
Manage Resources AllPartcipants
Maintain Serviceability
Scaleabil Cisco Routers 67 84%
caleabilty Desktop Replacements I 17.25%
Responsiveness EMC Symmetrix I 544 1%
Resources IT Portfolio Optimization
Minimize Risks Dynamic Analysis for All Participants
Leverage Proven Technology All Participants o :
Ensure Readiness Objective Priorties b« Altematives I3
Leverage Knowledge 30.06% Cisco Routers 76.84%
Vendor
Business Improve Organizational Efficiency 26.77% Deskiop Replacements 58.30%
Financials - - - _EMC s " 6.91%
Maximize NPV Maintain Serviceability 7.69% ymmetrix X
. o IMinimize Risks 16.78% Firewall and Antivirus Licenses 83.12%
Financials 18.70% Iron Mountain Backup Service 68.16%
Laptop Replacements 39.09%
Mobile Workforce Pocket PCs 4088%
Oracle 9i Upgrade 74.33%
PeopleSoft Upgrade 59.23%
Plumtree Corporate Portal 100.00%

¢ Moved the Components button to the left

ProServe System Upgrade 71.82%

Inconsistency Improvement screen updates

e Renamed "Rank" to "Rank by Inconsistency”

o Added tooltip for Best Fit and Rank by Inconsistency

Judgment Table

If elements in the table are sorted from high to low priority, then judgments should generally be increasing in any row from left to right, and in any column from
bottom to top. Although exceptions to this pattem are valid, they may indicate a judgment that should be examined for accuracy.

® Sort by priority
Sort by original erder
Vendor/Partner Access

Vendor/Partner Access

Internal Access

e 2e%
Customer Access/Service
[ 1 18%

Internal Access Customer Access/Service

33 \

Click a cell in the upper matrix to review or revise a judgment, including missing judgments. To change several judgments at once, click "Make changes on this

(] Rank by Inconsistency @ Make changes on this screen

() Re-evaluate a pair
[ Best Fit

Please review your resu

"Best Fit" shows the judgments that fit best to

screen’
Inconsistency ratio: 0.02

(® Copy to clipboard
W Paste from clipboard

Restore judgments

Priorities »

If the results do not make sense, use the Navigation box to review and edit any clerical errors.

reduce inconsistency. It is not advisable to

\tion Box @ change judgments to the 'best fit' values, but
rather use the ‘best fit' values to give you an

381 | .. 10 | 1 | 12 | 1 idea of which judgments you might want to
reconsider in order to reduce the
inconsistency.

uts [ o i ¥

o Improved the sorting (use radio button)
e Renamed "Review all judgments in cluster" to

inconsistencies"

Next Unasse

Previous

Version: 6.1

View as Evaluator
232/1232 U

"Re-evaluate a pair"
e Renamed "Click here if you think the inconsistency is too high" to

"Click here to investigate comparison matrix and

Click here to investigate comparison matrix and inconsistencies I

Click here to review all your judgments I
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e Removed "Click here if you would like to redo judgments for one pair of elements" since it is just redundant to the Re-
evaluate pair option on the Judgments Matrix

Font Size in Sensitivities

Added a font size dropdown on all the Sensitivity screens (Dyamic, Performance, Gradient, 2D, H2H, and Sensitivity Alternatives)

x Font Size
= E Local  Global “) Reset 1;1_ Dzefauh - | @ Objective Colors @ Alternative Colors
> Overall Results 2
tls Aliematives Chart ... Filter altarnatives: 10 {U rmalize Options: @ Ideal Ol include ideal al cis Deci
N Obiecti abn 3 i i
@' Objectives Chart < r—y > Show all alternatives 12 \ of Maximum « O Distributive nclude ideal alternative 2
A Alternatives Grid F
14 - Default .
FT Objectives Grid P IT Portfolio Opt

Dynamic Analysis for /

> Sensitivity A Objectives 18 ipants

B —— I Otjecve Poics |
== Dynamic 20 jective Priorities |*
iiis Performance Leverage Knowladge ~ecverage Knowledge

i Vendor/Partner Access
H= Gradient . Improve Organizational Eficiency

- , .
|«® 2D Customer Access/Service

= Head-to-head Maintain Serviceability

Internal Access

-EHMy‘LAt} —-w‘)_..lfrwu,wgwdﬁ, - S S Pt

Quick Help Enhancements

Quick Help is a custom help that can be set up by the Project Manager which will be displayed during the evaluation process.
The following enhancements are added:

o Text-to-speech on the Quick Help pop-out
e Changed the pop-out heading to orange
e Made the pop-out window wider

Quick Help ¢_I_. x §
How to evaluate using Multi-rating:

The fastest way to enter a rating is to click on an intensity name Jsuch as "Moderate to Good” at the right side of the page. Afier clicking the intensity name, the highlight advances to the next alternative. The priority
corresponding to the verbal intensities are shown also at the right of the page.

Rate the preference of Alternatives with respect to Performance

& Toyota Camry @, 2 Performance @,

Some factors to consider:
* Acceleration

Toyota_Camry

¢ Handling
* Braking

* Safety Features

Toyota Camry -0 Good v | 03600 % Toyota Camry
BMW 5 Series Not Rated - Outstanding [, oo oo
Excelent N o0
Good to Very Good _ 55.60%
Good [ 4670%
&, Moderate to Good [ ] 36.00%
Moderate | | 2590%
Clicksto,play, ATad | 400%
readithe texts tone oy B
(readithe texts)
Don't automatically show for duration of this session > n Edit Close

Custom Column in TeamTime Meeting

We applied the Custom Column functionality to the TeamTime meeting (previously only on AnyTime evaluation). The custom
column allows the Project Manager to select another user or group to display on the results step instead of the default
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"Combined" results.

lime

How close are your estimates of relative shape size to the actual measures?

Now, imagine that you can accurately measure intangible objectives like customer satisfaction, safety, or the likelihood of outperforming the S&P 500 in the same way.

Area Validation Exercise

[ Normalized v
No. & Name Zyza Bayth Actual Sizes Bar Graph
1 CIRCLEA 18.3%% 47.52% __
I |

2  TRIANGLEB 26.85% 4.90% =

3 SQUAREC 21.78% 23.19% =
I

4 DIAMOND D 24.3%% 15.08% [r—

5 RECTANGLE E 8.6%% 9.31% =

Inconsistency ratio- 1.38

This is set up from Set Measurement Options > Participant display options:

& MANAGE MODELS ‘ 7 DEFINE MODEL = ERSa gLl (= SYNTHESIZE | 42 ALLOCATE | @ DASHBOARDS | & REPORTS
rs

x Participant display options ~ ~ Set Measurement Options
#= Evaluation status L e e S e S8 e s s sy S
et Measurement Options . After collect input
B Anytime Evaluation (@ Stay on the evaluation

(O Close browser window (tab)

5% Send Invitations (O Redirect to UR

8 Collect my input

Choose...

B Collect my input (responsive) Perform user log-off
7 Data Grid
2e2TeamTime ™ Evaluation
2, N Intermediate Results Overall Results
2sZSelect Participants Hide O Hide

o TerotT
[l Display "expected valug' if applicaple [_] Display 'expected value' if applicable
() Show index Show index

Show Normalization option Show Nor jon option
Show priority bars Shovpe ars
Intermediate results sorting Over; ults sorting

@ No sorting ustom combined user pg 0 sorting

) Sort by name ort by name

(O Sort by individual priority
< () Sort by combined priority

B2 Invite Participants Individual (AnyTime Evaluation onl i . .
& Start/Stop Meeting O Actual Sizes (real@expertchoice com) € r O Actual Sizes (real@expertchoice.com) € I
<

The "combined’ resulis shown during an anytime evaluation (if the oplion is on) can be (°'t By indvidual priority
customized to show the results for an individual participant that has results instead of the |2't b combined priority
for all YYou can also specify the text to display along with these results.

|
3 Show welcome page Please select user: [ Actual Sizes V] |

[ show thank you page |
Custom title: ‘Actual Sizes | 1

[ show "Reward" page instead when participan

Show full objective path: @ Never O Always O Al OK Cancel

Question Text-to-Speech: () Disabled (O Auto-play (when available) @ Play on demand

Select Participants in View Only Evaluation

We added a participant selection dropdown on the View-only evaluation, this way the Project Manager can easily review different
participant's evaluations without going back to the Evaluation Progress screen to select another user.
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& MANAGE MODELS | = DEFINE MODEL =TedIISwgl izl (= SYNTHESIZE | &le ALLOCATE | @ DASHBOARDS | & REPORTS
s

View Only Mode. Your judgments will not be saved. (<Dave@expepichoice com=, Dave)

Welcome to Expert Choice Comparion®

evaluate factors influencing a decision, and alternative decision choices.

Select participant... X

admin, Administrator

Comparion® is a collaborative decision tool on the web where a team can come toge
Please click "Next" o answer a series of questions.
I you need help, click the help icon (@) near the top right of the screen.

After completing the task on a page, you simply need to click 'Next' to continue. You may be alerted &

3 Do

Dave@expertchoice com, Dave
Kris@expertchoice.com, Kris
Marcia@expertchoice com, Marcia
Pete@expertchoice com, Pete

selly@expertchoice com, Facilitator

Do Do Do Do Do

Steve@experichoice. com, Steve

Close

""‘rr"‘l"“‘".}" _JU‘_*J&—WJ_")J"“'J‘“")'“JM‘J“J

Gradient Sensitivity Legend Lines

We made an improvement that when the alternatives at the right are sorted by priority, the alternatives will be aligned to the
corresponding intersecting point (vertical blue line to the objective lines). We also added optional legend lines to see the
connection from the alternative to the intersecting point.

Normalize Options: @ Ideal O ‘ . Decimals: Sort Objectives by: Sort Alternatives by: &
~ || Unnormalized ~ (O Distributive Include ideal alternative E CI5 2 o~ None ~ |.‘: !

IT Portfolio Optimization
Gradient Analysis for All Participants

I Legend: Show Hidel Legend lines: Show Hide Leverage Knowledge ~

All Participants
100%

90% |
) 87.48% Plumtree Corporate Portal

80% | . . | .
H_.____________._H»f// 76.24% Thin Client Implementalion
.llI-IlIlIIll-q-llllttqllUIIU.

T0%

60% T . | | | |
\ _ 54 17% Oracle 91 Upgrade
50% | 7“"‘-—-_‘_____ ] 53.98% ProServe System Upgrade
 ———  \@5268% Cisco Routers
50.32% Sales Force Laptops

@ 41.09% EMC Symmetrix

0%
— \@39.18% Deskiop Replacements
_/*\1*:-‘%:_‘_\ \@37.70% Firewall and Antivirus Licenses
0% T — i".as.ag% PeopleSoft Upgrade
\ 36.56% SRDF Site/Service
| ®23.23% Mobile Workforce Packst PCs
\'@31.93% Iron Mountain Backup Service
20% 1 \®24.99% Laplop Replacements
10% | | | | |
-’-HJ___,A-—-"'-—-“‘""-‘ ._‘."—’“J"“J" \-""‘—w“’-”w‘

Edit Model Name

The Project Manager can now edit the model name by double-clicking or right-clicking the model name at the top.
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Expert Choice .
Workgroup:
@compa rien Comparion mm¥l: IT Portfolio Optimization I LTy
& MANAGE MODELS _ [USZLIS l)EM E COLLECT INPUT ‘ = SYNTHESIZE ‘ ’ C — DS | & REPORTS
i IT Portfolio Optimization

x
.
«»» DEFINE MODE
(@ Model Description "
- . Define model is where we ' ture " a decision mode! by identifying Objectives (criteria) and Alternatives as well as identifying decision participants and assigning them roles. Prei
[ Description/Details visit our HELP SECTION.
SJTeamTime™ Brainstorming
©Review / Refine Model MODEL DESCRIPTION FOF 'GOAL: OPTIMIZE IT PORTFOLIO TO IMPROVE PERFORMANCE' DEFINE PARTICIPANTS 4
£5 Alternatives N 3 N
* Objeci D Description/Details Q TeamTime™ Brainstorming (] .':} Participants
22 Objectives
£5 Contributions
@ Information Documents REVIEW / REFINE MODEL SET MEASUREMENT OP|
282Defi rticipants & rol - i
- . f ne pa cipants & reles E= Alternatives Edit Model Name x gIo Measurement Methods
=s=Parficipants . )
@ Participant Roles iaa Obiecives Model name-
g Set Measurement Options [ 1T Portfolio Optimization| | DEFINE INSIGHT QUES
&leMeasurement Methods. Pre-Survey
B Define Insight questionnaires
B Pre-Survey Save Cancel
B Post-Survey

<
e N R I e TPV NS Sy

Radar Sensitivity Enhancements

The Radar Sensitivity objectives bars are now draggable so we can see how the change in objective priority can affect the
alternative priorities, the bar colors are also updated based on the color settings.

IT Portfolio Optimization
Performance Analysis for All Participants

I Rl
All Participants Obijective Pricrities |* Alternatives
Leverage Knowledge (30.06%) 100%
90%
- A ™
L 80%
A 79.09% Plumtree Corporate Portal
4 —= @ 73.30% Thin Client Implementation
N H70%
Financials (18.70%) -~

- 0% —=@61.00% Cisco Routers
- 59.08% Oracle 9i Upgrade
57.04% ProServe System Upgrade
3 F:-@5372% Sales Force Laptops
+50% \.53.32% Iron Mountain Backup Servi
\'»@52.78% EMC Symmetrix
\‘51.96% Firewall and Antivirus Licens
\»@46.43% Desklop Replacements
4586% PeopleSoft Upgrade
= 45.47% SRDF Site/Service
~#33.51% Mobile Workforce Pocket P
r30% —.@30.21% Laptop Replacements

+40%

20%

10%

Open Model Lookup to another window

We added a toggle to open a separate non-modal page in a new window.This is helpful so that you can easily use the page look-
up to navigate to different pages without having to close the pop-out window.
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group -
sarion model: IT Portfolio Optimization @i N

TINPUT | = SYNTHESIZE ‘ & ALLOCATE ‘ @ DASHBOARDS ‘ = REPORTSVT

Define model is where
visit our HELP SECTION | @ [search

» @ Manage Models
MODEL DESCRIP' \l
~ & Define Model

[) Descrintion/Details

@ Tl 7yza Bayta -
£ Reload @ Online g Lock Snapshots i}

€ Page lookup [IT Portfolio Optimization] — Comparion ® - Google Chrome

ticipants and assignin
‘ . g _expertchoice.com, 3

DEFINE PAR || e
» o Manage Models

&

Parti ity
+ @ Model Description e D Vadel
~ & Ueline Model
+ @ Review | Refine Model

REVIEW ! REFINE . \l
» Zs2Define participants & roles

- |
Eg Alternatives » % Set Measurement Options

® Model Description
» © Review / Refine Model

. » ZsaDefine participants & roles
4ap Objectives + B Define Insight questionnaires )
» ®gSet Measurement Options
» &3 Collect input |
P + B Define Insight questionnaires

Pre-Survey o
» @8 Collect input

+ |2 Synthesize
+ &Allocate

[ Synthesize
@ Dashboards

BAlocate
+ & Repors
= rep @ Dashboards

= Manage Workgroup

& Reports
26 Personal Settings

a =2 Manage Workgroup
Resource Center

26 Personal Seftings
= Send Feedback

B Resource Center

(+ Logout
& Send Feedback
(+ Logout
) (=1l Close

"Forgot password" option on the Signup/Login page

Added the Forgot Password option on the signing-up/logging-in page:

Sign up or log in below.

MNew users login here: Existing user login:

E-mail*: E-mail*:
Full name: Password:
Password*: .
Log in
Confirm password®:

Sign up

@ | forgot my password

Re-arrange columns on the Alternatives/Objectives Grid

The participants and groups columns can now be re-arranged by drag/drop.
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2= & Local Global @ Colors... | [« Show bar chart
Filter alternatives: Mormalize Options:
:ﬂz 39 Show all alternatives v Unnurmalizid w g ::(}jii‘tarlibutive :::i:: ::; Ulinclude ideal alterna
IT Portfolio Optimization
Alternatives Grid

& =
1D Alternative Name All Participants Steve Facilitator
2 Cisco Routers 61% _42.83% 59.65% @
4 Desktop Replacements _48.43% = 22 26% _39.39%
5 EMC Symmetrix 52.78% _36.9% _45.3?%
B Firewall and Antivirus Licenses i%% — 25.82% _43.58%
T Iron Mountain Backup Service 53.32% — 25.85% _45.99%
8 Laptop Replacements _3[].21% . 19.81% - 24 31%
9 Mobile Workforce Pocket PCs _33.51% . 20.16% _31.?8%
10 Oracle 9i Upgrade 59.08% _ 3_8.5?% _ 55.65%
1 PeopleScoft Upgrade 45.86% 25.22% 43.86%
12 Plumtree Corporate Portal 79.09% 59.93% 83.38%
13 ProServe System Upgrade 57.04% 31.42% 59.17%
14 Sales Force | aptons h3 72% 32 BA% AR B1%

Show Model Name and Description in CS Meeting

We added a heading on the Collaborative Structuring meeting to show the Model Name.

Expert Choice

‘comparion

:: fi Joh

£+ Refresh

O =~

| Visual Brainstorming for model "IT Portfolio Optimization” ,"L
BT tormed Elements

Q- me

Goal: Optimize IT Portfolio To Improve Performance

- Leverage Knowledge

Vendor/Partner Access

Customer Access/Senvice

Internal Access

= Improve Organizational Efficiency

Improve Service Efficiencies

Leverage Purchasing Power

Improve Time to Market

Pros

Pros and Cons Summary

Cons

Q0

Goal: Optimize IT Portfolio To Improve Performance # @

Double click any empty position on this scre
© 01.Cloud
Migration (Vendor
selectedin
Pros Cons
very good ROI risky

© 05 Firewall and
Antivirus Licenses

en to create a new alternative

e

e

‘M"i\ﬁl'} it ot B J’m, . ._,,.__,_.__’ Y e _HHJ——‘" b Py
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We also added a Model Description pop-out when starting the Collaborative Brainstorming meeting. The pop-out will
automatically show up unless disabled by the Project Manager. It can also be opened from the i icon.

Visual Brainstorming for model "IT Portfolio Optimization with RA" %

Show Model Description

= HTEEN 30bjectives m
Goal: Optimize rtfolio To Improve Performance # @
osepesemon e e

Project Portfolio Management - evaluation, prioritization, selection, and budgeting of investments / initiatives (projects, assets, = |
people) that provide the highest contribution to the strategy.

"Do the right things."

GADGET .

AUTOMATION
f ROBOTS & INDU!

TECHNOLOGY

§EZ
S
NEWEST § caoctr 2 MEDIA Yy % x4 [ |
mes_pJ”t 2 E“—'S Qg
: CORE iy Og
MACHINE —_Es
SE2em g Di _)q_(r g vAlulU
=1 : mm 5 e
INNOVATION’
“IEMOVE ]

Don't show this anymare
X Close

Model Details Summary
The model details summary is viewable from the Models list and Model Details page"

+ IT Porifolic Optimization T 101272023, B.45.55 AM o©

IS ZEE - | 101212023, 5:51-42 AM [ o)
[ Model name: IT Portfolio Optimization

= Model Type: Regular

B Model Status: Active 15 WSJF
o' Access code: 4327-3627

4 Meeting ID: 538-205-230 - 1 10/10/2023, 11:59:09 PM
© Status: On-line

® Created: 7/17/2023, 3:38:50 AM

@ Last modified: 10/12/2023, 4:59:49 AM
( Last Access: 10/12/2023, 6:45:55 AM
aa Your Role: Project Manager

£ vVersion: 1.1.55

- | 10/11/2023, 10:17:41 PM

= | 10/10/2023, 11:07:28 PM o

- 10/10/2023, 12:12:51 AM

MANAGE MODELS I:ii :li;a:ﬂl COLLECTINPUT‘ SYNTHESIZE‘ ALLOCATE| DASHBOARDS | REPORTS B O aib @,

x

1D: 23823

[B Description -
Model name: IT Portfolic Optimization

[ Model Details

[=F

Model Description

e g with RA
Description/Details . Comparion® Model Name: * | |T Portfolio Optimization with RA Description: IT Portfolio Optimization -

£ TeamTime ™ Brainstor..
© Review / Refine Model

£ Projects

o Ob]ectlves

£5 Contributions

@ Information Documents
2s2Define participants & roles

2e2Participants

& Participant Roles
%nSet Measurement Options

&léMeasurement Methods <
B Define Insight questionnair_..

B Pre-Survey

i Post-Survey

Model description:

Model Assumptions:

Access code: *

Project Portfolio Management - evaluatic
budgeting of investments / initiatives (prc
provide the highest contribution to the st

"Do the right things."

GADGET

AUTOMAHON

4376-2181 & @ GetLinks...

~ Available by access code

Whiteboard available
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2017Project Portfolio Management -
evaluation, prioritization, selection, and
budgeting of investments / initiatives
(projects, assets. people) that provide the
highest contribution to the strategy. "Do
the right things.”

Model Type: Regular

Model Status: Active

o' Access code: 4376-2181

f4 Meeting ID: 635-665-235

© Status: On-line

@ Created: 9/4/2023, 7:46:21 AM

(@ Last modified: 10/12/2023, 6:50:43 AM
(O Last Access 10/12/2023, 6:50:43 AM
24 Your Role: Project Manager

jor] |

£ Version 1.1.55
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Tooltips to spell out labels on RA Columns

We added tooltips to spell out the labels for Expected Benefits, Probability of Success, and Probability of Failure.

| Groups »»

Max

Scenario;
[ | Drag a column header here to group by that column v| Auto-solve | 10 mil budget -

ID  Info  Projects

11 @ 11 Salesforce.com Corporate Portal
15 @ 15 Multi factor authentication
16a. Customer Service Call Center - Gold

05. Firewall and Antivirus Licenses

06. Iron Mountain Cloud Backup Service
9 @ 09 Oracle 12 Upgrade
17 @  16b. Customer Service Call Center - Silver
18 @  16c. Customer Service Call Center - Bronze
4 @ 04 EMC VMAX Enterprise Storage

12 @ 12 Building access system upgrade
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Funded

Cost of Deli | E. Benefit

1.0000 0.8236

0.8687 0.8011
0.7118 0.5369

0.6344 0.5850

0.6761 0.6235

0.6728 0.56512

0.6666 0.5683
0.6413 0.5467
0631 0.5820

0.6507 0.5547

‘B #% Risks~ % Download~ = More..~

Risk P. Syccess P. Failure Duration
__ 0.1764 1,345
_ b.oerv 0.9221 0.0779 2,100
- 0.1749 0.7543 02457 950
. 0.0494 0.9221 0.0779 120
_ 0.0527 0.9221 0.0779 430
_ 01216 0.8192 0.1808 1,890
_ 0.0983 0.8525 0.1475 890
_ 0.0946 0.8525 0.1475 800
_ 0.0491 0.9221 0.0779 4,220
0.0960 0.8525 0.1475 2,300



